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Welding Distortion - Overview

e \Welding Distortion:
e Target application: Mechanical

e Description: Predict distortion in metal components connected by
welding toes.

The version of the App and the supported versions of ANSYS are the
ones indicated on the App Store.
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ACT App Store ANSYS App Store

® https://appstore.ansys.com/shop/ACTApps act%20apps

e Great place to get started
— Alibrary of helpful applications available to any ANSYS customer
— New apps added regularly

— Applications made available in either binary format (.wbex file) or
binary plus scripted format (Python and XML files)

— Scripted extensions are great examples

— Documentation and training materials available on the ANSYS
Customer Portal:
https://support.ansys.com/AnsysCustomerPortal/en us/Downloads/AC
T+Resources
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https://appstore.ansys.com/shop/ACTApps_act%20apps
https://support.ansys.com/AnsysCustomerPortal/en_us/Downloads/ACT+Resources

A >YS App Store

Information

® Please pay attention to paragraph 9 of the CLICKWRAP SOFTWARE
LICENSE AGREEMENT FOR ACS EXTENSIONS regarding TECHNICAL
ENHANCEMENTS AND CUSTOMER SUPPORT (TECS): “TECS is not
included with the Program(s)”

® Report any issue or provide feedback related to this app please
contact:

Contact email address: abel.ramos@ansys.com

5 © 2018 ANSYS, Inc. ANSYS Confidential



Binary App Installation (1)

ls  Units  Extensions Jobs  Help

Installing from the ACT Start Page: o
Reconnect Refresh Project Update :'-':-;E::I ==ACTStartEagE l

1. From the project page, select the
“ACT Start Page” option

2. Click on “Extension Manager” - 3
- v
3. Press “+” symbol in the top right corner = A

4. It will open a file dialog to select the
appropriate “*.wbex” binary file

5. The extension is installed

Manage your extensions

UNYEE ACT | =

E:
=
| [l s-~- 0O @
+ @ %+ Hard Disk Drives (3)
L
o

Install new extension

Loading the extension:

1. From the Extension Manager, % o
click on your extension and choose o B il
‘Load Extension’

2. The extension is loaded

Notes:
* The extension to be installed will be stored in the following location: %AppData%\Ansys\[version]\ACT\extensions

* The installation will create a folder in this location, in addition to the .wbex file
* Example for [version]: v180

6 © 2018 ANSYS, Inc. ANSYS Confidential



7

Binary App Installation (2)

Installing from the Extensions menu:

1. From the Extensions menu, select the “Install
. -
EXtens’on""’ optlon Fi\e \c"w Tools Un hensions Jobs  Help

Jljl‘ﬂl‘ﬂ’l Proj BB ACT StartPage

Reconnect | Manage Extensions...

2. It will open a file dialog to select the appropriate
“* wbex” binary file

B ACT Start Page

Install Extension...

|E| Analysis Systems Build Binary Extension. ..
B3 Eigenvalue Buckling View ACT Console
H “ ”» H H ) )
3. Click “Open” to install the extension B 2armdis o155 g
[&) Electric
B3
e »
0 e

Loading the extension:

1. From the Extension Manager,

MMMMM

click on your extension and choose ‘Load Extension’

aaaaaaaa

2. The extension is loaded

Notes:
* The extension to be installed will be stored in the following location: %AppData%\Ansys\[version]\ACT\extensions
¢ The installation will create a folder in this location, in addition to the .wbex file
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Binary App Installation (3)

* Once the binary extension is installed at default location, one can move the *.wbex and the folder to
any other location

— Default path: %AppData%\Ansys\[version]\ACT\extensions
— New path: Any location on your machine, shared drive etc.

* All users interested in using the extension need to include that path in their Workbench Options
— In the “Tools” menu, select the “Options...”

— Select “Extensions” in the pop up panel

— Add the path under “Additional Extensions Folder ...”

g [ 3

- Project Management
Appearance

Extensions

fﬂ Unsaved Project - Workbench

File  View | Tools Units
J J H Reconnect

JM [4] Refresh Project

Update Project
Toolbox )

Extensions

Jobs

Help

- Regional and Language Options
- (Graphics Interaction
- Journals and Logs
- Project Reporting

- Solution Process

EEmy<—| 2

- Mechanical APDL

—General Options

A4

Additional Extension Folders {enter folders separated by ;)
IE: WACT\Install_Extensions;E: \ACT \Instal_Extensions2

Save Binary Extensions with Project

INever

=

- Repository
- Mechanical
- Microsoft Office Excel

roevelopmet—| Define additional folders in which ACT

 Jurbosyste I pebuaiede| \yjl| search for extensions in order to

i Li Prefe - Meshing . )
B Analysis Sy ICENSE Freferences {&- Design Explaration expose them in the Extension Manager
[ Eigenvalu Release Reserved Licenses. .. - Geometry Import
[l Eigenvalu 1
Electric Restore Defaults | OK | Cancel I
| BExplicit Dynamics
Notes:

* During the scan of the available extensions, the folders will be analyzed according to the following order:

1. The application data folder(e.g. %AppData%\Ansys\[version]\ACT\extensions)
2. The additional folders defined in the “Additional Extension Folders” property

3. The installation folder

4. The “extensions” folder part of the current Workbench project (if the project was previously saved with the extension)

* If an extension is available in more than one of these locations, the 15t one according to the scan order is used
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Documentation

The objective of this wizard is to automate the set up creation to
simulate the welding process in ANSYS Mechanical in order to
predict welding distortion

Assumptions:
W || BT *  Weld geometry will be manually
S prepared on SpaceClaim
2O o e —— e Mechanical Script will automatically
S @ sew Va om@m "
- 7 L s create all the contacts for the
Transien t Thermal Static Structural Welding’ the analysis Settings time
stepping and ekill/ealive controls
needed

*  Weld is assumed to be deposited at
a user defined temperature and
cooled down to room temperature

* Material Properties defined by user
on Engineering Data. Properties
dependant on Temperature, but not
phase changes defined.
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Realize Your Product Promise®

Simulating welding process - Wizard




o
Wizard goroad
o Project -
- 3] Model (C4, D4)
[, Geometry
[, Materials
[k Coordinate Systems

-, A Mesh

- G Named Selections
Name Selection Automatic Creation B s
....... 01 TARGET3

If WELD1, WELD2, ...., WELD3 wants - /8 wnes

....... B B
------- 1B WLINE2

to be automatically created,youcan ‘@ ot

....... v B WLINE3

use two name selections {00 e Thermal €5)

....... v 7=p Initial Temperature

 WLINEi: Cointaining all the bodies @ V7 Aoy Sets

------- AP Convection
-] Solution (C6)

in the weldingline & /21 St nformtn

A Temperature

* B1_WLi: Defining the first body in =43 mmm £
the welding line outine »

J Filter: Mame -

@ a4+ ®e 4
(&) Project ~
B @Hndel((q,m]

Where “i” corresponds to the number o T
of the welding line 1,2,3....,n v CordneteSystens
= '/% Mesh

= 1 Named Selections

....... O] TARGET1
....... »[C] TARGET2
....... v n TARGET3
....... v B WLINEL
....... v B B1_wL1
....... B WLINE2
....... v . B1l_WwL2
....... 1B WLINE3
....... B BLWL3
=-{@] Transient Thermal (C5)
....... S -rE:a Initial Temperature
....... v 7 Analysis Settings
....... ﬁ ] Convection
-6 Solution (C6)
& ¥] Solution Information
b, //Q Temperature
= _;E' Static Structural (D5)

ANSYS



5
Wizards ACT

lea rd : Install: S_WeldWizard.wbex

=
mn:
w8

z 10

Wizard

ACT * Automatic Creation of NS:WELD1,

/ WELD?2, ..., WELD3
Mechanical ~ Ns1-Skip/0-Create * Number of welding lines
Model S - Input required. / ) ]
Weiding . Nwelsingtoes * Table with the number of bodies
Process Input required. / . "
M of welding bodies on... | Tabular Data m On eaCh Weldlng Ilne

Input required.

Total welding time sec /. TOtaI Welding time
— __————+ Total cooling time

et Temperatre . * Reference temperature
e g R -~ Create contacts (0) or use Shared
- onmtacts-znare topo

Input required. topolgy (1)

E: Simple Weld Wizard EAASAE

Total cooling time sec
Input required.

Help .

;{3 Static Structural (BS)
; ----‘//'\ Analysis Settings
E|(_| Imported Load (AG)
/—)l Imported Body Tempe
- il Element Birth and Death
v, il Element Birth and Death 2
(J Element Birth and Death 3
- o Element Birth and Death 4
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Realize Your Product Promise®

Simulating welding process
Workflow




Welding Process Project Example

feometrh Material Meshing Mechanical Post-Processing
<\Preparatiory Properties Set Up

Qutline

J Filter: mame

B 2t |_ el J
s l,,\ Bonded - Solid1 To Multiple
*, Bonded - Solid1 To Multiple
s B, Bonded - Solid To Multiple
B ,,% Mesh
ﬁ,\ Body Sizing
EI Eij Named Selections
J. WELD1
.(. WELD2
J. WELD3
B WELD4
J. WELDS
- [0 TARGET1
u---- ,,fra Transient Thermal (A5)
: ‘,T =P Initial Temperature
I Analvsis Settinns

Details of "Named Selections”
=) Display

User needs to define manually the order on which each body will be alive in the
simulation based on a Name Selection, starting form WELD1, WELD?2, ... up to WELDn

If you are not using shared topology, contacts will be automatically created. In this case,
for each weld, some targets faces need to be defined using a Named Selection:
TARGET1, TARGET2, .. TARGETm

Create welding geometry on SpaceClaim and

divide it in “n” bodies depending on resolution
required durlng simulation. Use share topology
to obtain a conformal mesh in the weld I\N\ TS




Welding Process Project Example

Geometry Material\ Meshing Mechanical Post-Processing
Preparation <Properties > Set Up

User can use standard Engineering data
to define the material properties used
in the simulation

Project Schematic

- A - B
8 = Static Structural

W 2 @ Engineering Data  +"

Sl Geomedy T K] ﬁ Geometry v

4 @ Model W g4 @ Model v

5 @ Setup v ‘—/—05 @ Setup v 4

B Solution v 4 B Solution v 4

¥ @ Results v o 7 @ Results v 4
Transient Thermal Static Structural
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Welding Process Project Example

Geometry Material Meshing /Mechanical\ Post-Processing
Preparation Properties \S\et Up %

* Automatic Creation of NS:WELD1,
WELD2, ...., WELD3. If 1, you need
Mechanical NS 1-8kip /0-Create _ to use WLINEi, B1_WLi as
Mot weiangmes [ explained on slide 13
e o m\\: * Number of welding lines

M of welding bodies on... | Tabular Data
* Table with the number of bodies

Input required.
Total welding time sec
Input required. . .
Total coaling time sec \ on eaCh WE|dlng Ilne
Input required. \ . .

E: Simple Weld Wizard EAASAE

* Total welding time
Melting Temperature c
Input required. \ * Total cooling time
0-Contacts/1-Share topo
nputrequired \ * Reference temperature
* Create contacts (0) or use Shared
Help topolgy (1)

;{3 Static Structural (BS)
: ----‘//'\ Analysis Settings
E|(_| Imported Load (AG)
/—)l Imported Body Tempe
‘/J Element Birth and Death
i Element Birth and Death 2

- +fl] Element Birth and Death 3
i +id| Element Birth and Death 4 ANSYS
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Welding Process Script Example

Meshing /Mechanical\ Post-Processing

Geometry Material
Preparation Properties
. Pm]ect i

B Model (A4, B4)
I ----- AT Geometry

I ----- ,/- Materials

- sk Coordinate Systems

-, Connections
----- @ Connection Group

B @ Mamed Selections
-8 WELD1
5------,,@ WELDZ
i B WELD3
,,lﬁ WELD4
i B WELDS
L TARGI:‘I'I

E......‘/'r_)a nioal Temperature
(f\ Analysis Settings

alx =Tl
Element Birth and Death
(J Element Birth and Death 2
- /i Element Birth and Death 3
i Element Birth and Death 4
-------‘/:l,\ Contact Step Control
------V‘l‘ Contact Step Control 2
-------‘,‘i,,\ Contact Step Control 3
- B, Contact Step Control 4

- [8 Commands (APDL)

- Bl Commands (APDL) 2

- /B> Commands (APDL) 3

- /B Commands (APDL) 4

- /B Commands (APDL) 5

- [8 Commands (APDL) &
S——
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/ wizard
|

wetlp

Automatically
created with the

User can input additional
boundary conditions and
contacts in the tree as needed

ANSYS Confidential




Welding Process Script Example

Example: Load Step 3

18
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Geometry Material Meshing /Mechanical\ Post-Processing
Preparation Properties Qet Up -
Procedure

The number of total Load Steps Automatically defined is the
number of welding bodies plus one additional to cool the
model down

The time defined for each WELDn body is TWtime/(number
of welding bodies)

Each new WELDnN body is activated at T=Melt Temperature
defined by the user. Temp is maintained during the load step
and is freed to cool down in the nexst load step

Temp = Cooling down
depending on B.C.

Temp = Melt_temp [2C]

Time = Twtime/5

.

) msisCodenal
L M e



Welding Process Script Example

Qutline

Geometry

Material

Preparation Properties

Meshing /Mechanical\ Post-Processing

wetp

Example additional boundary condition suggested

Thermal: Convection

JFiH:en MName hd

B ad=m e 8l

1e

[

J. WELD4

J. WELDS

‘/D TARGET1
Transient Thermal (AS)

,/:";f)f’ Initial Temperature

o e
ﬁ[ Convection

- /il Element Birth and Death 2
Jﬂ Element Birth and Death 3
‘/iﬂ Element Birth and Death 4
-------‘/‘I,,\ Contact Step Control
-------‘/‘I,,\ Contact Step Control 2
- s B, Contact Step Control 3
. @ Contact Sten Control 4

© 2018 ANSYS, Inc.

Structural: Displacements

Filter: | Name j

ARl =S -]

------- /il Element Birth and Death 2
------- v [t Element Birth and Death 3
------- v iﬂ Element Birth and Death 4
------- ) ‘l,,. Contact Step Control

------- .~ B, Contact Step Control 2
------- v :IL Contact Step Control 3
------- -~ B Contact Step Control 4

d_Remote Displacement

....... ./Ei” Displacement

....... AT, Displacement 2

',m Solution Information
& Total Deformation

Jetails of "Multiple Selection”

Displacements can be deactivated in
the last Load Step to calculate spring

back due to thermal loads ANSYS




Boundary Conditions - Tip

=--+|=] Static Structural (B5)
‘,{‘“\ Analysis Settings
B J_il Imported Load (A6)
i 25} Imported Body Temperature o,

Jetails of "Imported Body Temperature” 2
-|| Scope
Scoping Method Geometry Selection
Geometry 7 Bodies
|| Definition
Type Imported Body Temperature
Tabular Loading Program Controlled
Suppressed Mo

Source Environment | Transient Thermal [45)

-
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Under StaticStructural Analysis
Systems:

Define Source Time: All on the
Imported Body Temperature




Welding Process Script Example

21

Geometry
Preparation

Material
Properties

Meshing

© 2018 ANSYS, Inc.
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Mechanical
Set Up

<Post-Processing




Thank you Join -\-he,iA

e Abel Ramos

® abel.ramos@ansys.com
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